
Business System Standards

Overview
This chapter outlines the standards for the university’s business system documents — including business cards,
printed stationery, electronic stationery, PowerPoint presentations, email signatures, note pads, mailing labels,
facsimile cover sheets, employee name badges, special event name tags, note cards, printed or electronic agenda
templates and printed or electronic memo templates. The Department of Marketing and Strategic Partnerships
maintains the integrity of the university’s business system in conjunction with University Copy, the unit 
formerly known as the Print Shop. This section also outlines how to download templates for these documents
and place online orders for these materials through University Copy’s preferred business system vendors.
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Business System Standards

The components that make up the University of 
San Diego’s business system — including stationery,
business cards and other elements used in official
internal and external correspondence — are vital
components to its visual identity. The Department 
of Marketing and Strategic Partnerships maintains 
the integrity of the university’s business system in
conjunction with University Copy, the unit formerly
known as the Print Shop. To maintain the integrity
of the system, these materials must be ordered only
through University Copy’s preferred business 
system vendors.

How to Order Elements of the Business System
Most components of the university’s business system
are available to order through the University Copy's.
Other templates are available to download at the
Department of Marketing and Strategic Partnerships
website. Specific instructions for how to either order
or download each component are referenced in the
individual sections of this chapter.

Who Should Apply the Business System Standards
Anyone who is employed by the university or who
conducts official business on behalf of the university
should use the components in the business system.
The business system standards outlined in this 
chapter apply across campus to all academic units,
administrative offices and athletic entities.

Student Use of Business System Components
Components of the business system are reserved 
for employees only and, for the most part, are not
available to students. The only exception is that
graduate students, who are currently enrolled at 
the University of San Diego, may be issued student
business cards for the purpose of career networking
only. Students who carry these cards are not allowed
to act as agents of the university. Applications for
graduate student business cards must be authorized
by the administrators who oversee the students.
Undergraduate students are not authorized to carry
student business cards under any circumstance.   

The Official University of San Diego 
Letterhead and Envelopes
The stationery packages, which include official 
letterhead and envelopes, play a major role in the
university’s visual identity. The letterhead was
designed to highlight the University of San Diego’s
master logo, as well as its official school colors. 

The university’s spirit letterhead and envelopes may
feature only the master logo, not custom signatures.
This allows shells of the letterhead and envelopes to
be ordered, printed and stored in bulk, which saves
money for the university and expedites the time it
takes to fulfill orders for individual units.

The university’s traditional letterhead and envelopes
may be customized with school signatures. The 
letterhead and envelopes for administrative units 
or academic units that don’t fall within a school 
will feature the master logo.

How to Customize the Letterhead and Envelopes
The letterhead features a contact information section,
which can be customized to include the name of a
college, school, institute, center, program, department,
office or individual. The contact information section
is located at the upper right-hand of the traditional
letterhead, and at the bottom of the spirit letterhead.
The envelopes also may be customized with 
corresponding contact information.
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Stationery Package Options
To accommodate various budgets, the university
offers two stationery packages. 

• The spirit letterhead features the reverse version 
of the master logo.

• The traditional stationery package may feature 
only the master logo or a school custom signature,
but not custom signatures that fall outside 
those options. 

Letterhead and envelopes must be printed on
Thermo Rite, 24# bright white, or its equivalent. 
This stock contains 100 percent recycled materials.

Layout, formatting, type specifications and colors
may not be changed. The design of the letterhead
may not be rearranged, distorted or altered in any
way. All university entities are prohibited from 
creating their own letterhead or envelopes. To order
letterhead and envelopes, go to the University Copy’s
website at www.sandiego.edu/copy.

Spirit Line

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Traditional Line with the Master Logo (available in two colors or one color)

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Traditional Line with the Custom Logo (available in two colors or one color)

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492
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Electronic Letterhead
The university also offers employees the option 
of ordering electronic letterhead. The electronic 
letterhead is to be used in Microsoft Word and
should be used as an attachment to an email.
Electronic letterhead does not replace official printed
stationery. It is meant to be used only electronically.
It contains low-resolution images and does not
reproduce well when printed. It should never be
used with the intention that it will be printed and
mailed. Employees who need or prefer to print the
correspondence, should instead draft their letter on
the university’s official letterhead. Employees can 
create their own electronic letterhead, by customizing
the university’s official electronic letterhead templates.

Specific guidelines and instructions for how to 
customize electronic letterhead templates are 
embedded in the templates. Employees are encouraged
to use the save as function and rename their electronic
letterhead template file with a different name so that
they may retain the original master templates and
instructions on their hard drives for future use.  

To download electronic letterhead templates, go to
www.sandiego.edu/marketing/stationery.php.

All versions of the letterhead are available in electronic formats
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Composing a Letter on Letterhead
Garamond, a font available on all computers, is the
font that must be used when writing a letter on the
University of San Diego’s official letterhead. 

Spacing: 1.5 line spacing looks best. Single spacing is too
cramped and difficult to read. Double spacing is too airy.

Point size: 12 point.

Alignment: Text should be aligned flush left.
Paragraphs should not be indented. Instead, simply
insert an extra return between paragraphs.

Margins: Shown here are guidelines for how to 
set margins on various versions of the letterhead:
• Spirit stationery
• Traditional stationery
• The same specifications should be used when

composing letters on the corresponding versions
of athletic letterhead.

Completing a Letter on Secondary Sheets
The secondary sheet of the letterhead, used for when
correspondence is longer than one page, is plain, and does
not contain any design elements. The same paper stock
used for letterhead must be used for the second sheet. 
Use the guidelines shown here to ensure the proper setting
of margins for secondary sheets of the official letterhead.

DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

March 1, 2007

Diego the Torero

1234 Alma Mater Way

San Diego, CA 56789

Dear Mr. Torero,

Loem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod tempor 

incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim veniami quis 

nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea commodo consequat. 

Duis autem vel eum irure dolor in reprehenderit in voluptate velit esse molestaie son conse-

quat, vel illum eu fugiat nulla pariatur. At vero eos et accusam et justo odio dignissim qui 

blandit praesent lupatum delenit aique duos dolor et molestais exceptur sint occaecat cupidat 

non provident, simil tempor sunt in culpa qui officia deserunt mollit anim id est laborum et 

dolor fugai. Lorem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy 

eiusmod tempor incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim 

veniami quis nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex.

At vero eos et accusam et justo odio dignissim qui blandit praesent lupatum delenit aique duos 

dolor et molestais exceptur sint occaecat cupidat non provident.

Sincerely,

Mary E. Lyons, Ph.D.

President

Left
margin
1.25"

Right
margin

0.8"

Top
margin

2.5"

Bottom
margin

1.5"

Garamond
12 pt
1.5 line spacing

March 1, 2007

Diego the Torero

1234 Alma Mater Way

San Diego, CA 56789

Dear Mr. Torero,

Loem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod tempor 

incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim veniami quis 

nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea commodo consequat. 

Duis autem vel eum irure dolor in reprehenderit in voluptate velit esse molestaie son consequat, 

vel illum eu fugiat nulla pariatur. At vero eos et accusam et justo odio dignissim qui blandit 

praesent lupatum delenit aique duos dolor et molestais exceptur sint occaecat cupidat non 

provident, simil tempor sunt in culpa qui officia deserunt mollit anim id est laborum et dolor 

fugai. Lorem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod 

tempor incidunt ut labore et dolore magna aliquam erat volupat. 

Et harumd dereud facilis est er expedit distinct. Nam liber a tempor cum soluta nobis eligend 

optio comque nihil quod a impedit anim id quod maxim placeat facer possim omnis es voluptas 

assumenda est, omnis dolor repellend. Temporem autem quinsud et aur office debit aut tum 

rerum necessit atib saepe eveniet ut er repudiand sint et molestia non este recusand. Itaque earud 

rerum hic tenetury sapiente delectus au aut prefer endis dolorib asperiore repellat. 

Sincerely,

Mary E. Lyons, Ph.D.

President
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Lorem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod tempor 

incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim veniami quis 

nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea commodo consequat. Duis 

autem vel eum irure dolor in reprehenderit in voluptate velit esse molestaie son consequat, vel 

illum eu fugiat nulla pariatur. At vero eos et accusam et justo odio dignissim qui blandit praesent 

lupatum delenit aique duos dolor et molestais exceptur sint occaecat cupidat non provident, simil 

tempor sunt in culpa qui officia deserunt mollit anim id est laborum et dolor fugai. 

Loem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod tempor 

incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim veniami quis 

nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea commodo consequat. 

Duis autem vel eum irure dolor in reprehenderit in voluptate velit esse molestaie son consequat, 

vel illum eu fugiat nulla pariatur. At vero eos et accusam et justo odio dignissim qui blandit 

praesent lupatum delenit aique duos dolor et molestais exceptur sint occaecat cupidat non provi-

dent, simil tempor sunt in culpa qui officia deserunt mollit anim id est laborum et dolor fugai. 

Lorem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy eiusmod tempor 

incidunt ut labore et dolore magna aliquam erat volupat. Ut enim ad minimim veniami quis 

nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea commodo consequat. Duis 

autem vel eum irure dolor in reprehenderit in voluptate velit esse molestaie son consequat, vel 

illum eu fugiat nulla pariatur. At vero eos et accusam et justo odio dignissim qui blandit praesent 

lupatum delenit aique duos dolor et molestais exceptur sint occaecat cupidat non provident, simil 

tempor sunt in culpa qui officia deserunt mollit anim id est laborum et dolor fugai. Ut enim ad 

minimim veniami quis nostrud exercitation ullamcorpor suscipit laboris nisi ut aliquip ex ea 

commodo consequat. Loem ipsum dolor sit amet, consectetur adipsicing elit, sed diam nonnumy 

eiusmod tempor incidunt ut labore et dolore magna aliquam erat volupat.

Et harumd dereud facilis est er expedit distinct. Nam liber a tempor cum soluta nobis eligend 

optio comque nihil quod a impedit anim id quod maxim placeat facer possim omnis es voluptas 

assumenda est. At vero eos et accusam et justo odio dignissim qui blandit praesent lupatum 

delenit aique duos dolor et molestais exceptur sint occaecat cupidat non provident, simil tempor 

sunt in culpa qui officia deserunt mollit anim id est laborum et dolor fugai.
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Formatting Specifications for Spirit Letterhead Formatting Specifications for Traditional Letterhead Formatting for Second Sheets
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Business Cards
Official business cards are perhaps the most vital 
element of the university’s business system. Business
cards may feature only the master logo or a school
custom signature, but not custom signatures that fall
outside those options.

Business cards may not be printed in one-color 
formats. No other color options are available or 
otherwise sanctioned. 

Business cards must be printed on Fox River Run
Cover, 88#, or its equivalent. This stock contains 
50 percent recycled materials.

Layout, formatting, type specifications and colors of
the business cards may not be changed. The design
of the business cards may not be rearranged, distorted
or altered in any way. No other logos or marks may
appear on University of San Diego business cards.
All university entities are prohibited from creating
their own business cards. To order business cards, 
go to the University Copy’s website at
www.sandiego.edu/copy.

NAME
Title
Department
Name  

Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000
C: (619) 206-0000
F: (619) 260-0000 

e-mail@sandiego.edu
www.sandiego.edu/department

Spirit Business Card 
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Email Signatures
Email is perhaps even more widely used for 
daily correspondence than letters written on 
stationery. Therefore, the university adopted an 
official format for the email signatures of all 
campus employees. This format includes a standard
format for listing contact information. The email 
signature should not include the university’s logo or
other custom signatures or marks. The university’s
server cannot support email signatures that include
these types of files. For instructions on how to 
customize the university’s email signature template,
go to www.sandiego.edu/marketing/stationery.php.

Diego the Torero
Any Subject
March 1, 2007 3:55:41 PM PS
John Doe
1 Attachment, 5.1 KB

From:
Subject:

Date:
To:

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat 
volutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commodo consequat. 
Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel illum dolore eu feugiat nulla facilisis at vero 
eros et accumsan et iusto odio dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi.

Thanks.

DIEGO THE TORERO
Title
Department Name
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492
Phone: (619) 260-0000, ext. 1111
Fax: (619) 260-0000
diegothetorero@sandiego.edu
www.sandiego.edu
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PowerPoint Presentation Template
In an effort to promote recognition, maintain 
consistency, enhance visual appeal and improve
communication, the university has created a
PowerPoint template. The template is recommended
when communicating to external audiences. It also 
is encouraged for internal presentations. The template
simply ensures a unified color palette and logo
placement. It still offers flexibility in layout and 
in no way dictates content. To download the
PowerPoint presentation template, go to
www.sandiego.edu/marketing/stationery.php.

Presentation Title

Diego the Torero
March 1, 2007

Standard Slide

Section Title

Section Subtitle

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed 
diam nonummy nibh euismod tincidunt ut laoreet dolore 
magna aliquam erat volutpat.  
• Ut wisi enim ad minim veniam

• Quis nostrud exerci tation ullamcorper suscipit lobortis nisl 



NAME
Title
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Folded Note Cards
There are times when it’s appropriate to communicate
with constituents in a more personal, informal way.
Therefore, the university offers two color options for
note cards. One uses the master logo on an Alcalá
White background and the other uses the master
logo in reverse on a Founders Blue background.
Note cards may be ordered with or without 
personalization. To order note cards and corresponding
envelopes, go to the University Copy's website at
www.sandiego.edu/copy.

NAME
Title

Plain Note Cards

Personalized Note Cards



Business System Standards

University of San Diego Official Visual Identity and Communications Style Manual 120

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Flat Panel Cards
Flat panel cards are available in Alcalá White 
and may be ordered with or without personalization.
To order panel cards and corresponding 
envelopes, go to the University Copy's website at
www.sandiego.edu/copy.

NAME
Title
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Note Pads
The university’s business system also includes 
two sizes of note pads, a half-sheet size and a 
Founders Blue or black. Note pads should be
reserved primarily for internal communications. 
For personal communications to off-campus 
constituents, either official letterhead or official 
university note cards should be used. To order 
personalized note pads, go to the University Copy’s
website at www.sandiego.edu/copy.

DIEGO THE TORERO
Title
Department Name 

Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
C: (619) 206-6922
F: (619) 260-0000 

diegothetorero@sandiego.edu
www.sandiego.edu

DIEGO THE TORERO
Title
Department Name 

Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
C: (619) 206-6922
F: (619) 260-0000 

diegothetorero@sandiego.edu
www.sandiego.edu
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Formal Employee Name Badges
Employees should wear official name badges at 
functions where members of the community or 
constituents from off campus will be present.
Employee name badges should include the first a
nd last name of the employee, as well as the title
and name of the official unit that employee represents.
Employees who are alumni also should include their
class year next to their names. Employees who have
earned terminal degrees in their fields also may list
those degrees next to their names. 

Formal employee name badges are engraved on silver.
No other color options are available or otherwise
sanctioned. Layout, formatting, type specifications and
colors may not be changed. To order personalized
formal employee name badges, go to the University
Copy’s website at www.sandiego.edu/copy.

Informal Employee Name Tags
Employees and student workers who wear name tags
as part of an official employee uniform may order
more affordable plastic employee name tags. These
name tags may either be blue with white lettering 
or white with blue lettering that matches, as closely
as possible, Founders Blue, PMS 281. It is not 
necessary to include class years, terminal degrees or
other information on these more informal name tags.  
To order informal employee name badges, go to the
University Copy’s website at www.sandiego.edu/copy.

Name ’00 (Ph.D)
Title/Department

Employee Name
Department Name

 
 

 
 

Employee Name
Department Name

Formal Employee Name Badge

Informal Employee Name Badge

Informal Employee Name Badge
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Special Event Name Tags
The University of San Diego regularly hosts events
on the campus, to which members of the public are
invited. A template has been created for special
event name tags and should be used for all guests
who are attending an official university event. These
name tags should include the first and last name 
of the guest. The name tags also may include the
guest’s class year, if he or she is a USD alumnus 
or alumna, and the company or organization with
which that guest is affiliated. 

The name tags are perforated and can either be
slipped into plastic name tag sleeves or peeled away
from the backing and used as adhesive stickers.
There are three easy steps to using special event
name tags. 

• Step One: Employees must order pre-printed shells
of the special event name tags through the
University Copy’s website at www.sandiego.edu/copy.
These should be ordered well in advance of the
event at which they will be used. Departments that
host events regularly can order these pre-printed
shells in bulk and store them with their other paper
products.

• Step Two: Employees must download the special
event name tag template at www.sandiego.edu/
marketing/stationery.php and, using the template, 
type in the names of all guests who will be 
receiving name tags. 

• Step Three: Employees must insert the pre-printed
shells they received from University Copy’s into
their desktop printers and print their list of names
on the shells.

       

Special Event Name Tag (Avery Label 5395 Template)

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Type Name Here
Type Company Name Here

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Visitor Name
Company Name

Step One: Order sheets of
pre-printed name tag shells

Step Two: Fill in the template 

Step Three: Final printed name tags
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University Envelopes
The university also designed several sizes and 
styles of envelopes to accommodate many different
mailing or packaging needs. To order various
envelopes, go to the University Copy’s website at
www.sandiego.edu/copy.

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Envelope 2 color 12" x 15"

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Envelope 2 color 9" x 12"

Envelope 2 color 6.5" x 9.5"

Envelope 2 color 10" x 13"
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DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Type Name Here
Type Address Here

Type Name Here
Type Address Here

Type Name Here
Type Address Here

Type Name Here
Type Address Here

Diego the Torero
1234 Alma Mater Way
San Diego, CA 56789

Diego the Torero
1234 Alma Mater Way
San Diego, CA 56789

Diego the Torero
1234 Alma Mater Way
San Diego, CA 56789

Diego the Torero
1234 Alma Mater Way
San Diego, CA 56789

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

        

DEPARTMENT NAME
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

Mailing Label
(Avery Label 5168 Template)

Mailing Labels
Although the university offers several sizes 
and styles of envelopes that can be ordered and 
customized through University Copy, there may be
times when materials must be mailed using boxes or
other types of packaging. When sending materials in
boxes or other types of packaging, use the 
university’s mailing labels. 

There are three easy steps to using mailing labels. 

• Step One: Employees must order pre-printed shells 
of the mailing labels through the University Copy’s
website at www.sandiego.edu/copy. These should be
ordered well in advance. Departments that mail
packages regularly can order these pre-printed
shells in bulk and store them with their other
paper products.

• Step Two: Employees must download the mailing label
template at www.sandiego.edu/marketing/stationery.php
and, using the template, type in name and address
of the persons or organizations receiving the packages.

• Step Three: Employees must insert the pre-printed
shells they received from University Copy into their
desktop printers and print their mailing labels on
the shells. 

Step One: Order sheets of 
pre-printed address label shells

Step Two: Fill in the template

Step Three: Final printed mailing labels
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Action Memos
The university offers an action memo that may be
personalized with a person’s name and title. To order
personalized action memos, go to the University
Copy’s website at www.sandiego.edu/copy.

Action Memo

To:

Date:

Comments:

1.   ❑  For your information

2.   ❑  Please handle

3.   ❑  Please advise/comment

4.   ❑  See/call me ________________

5.   ❑  For your approval

6.   ❑  For your signature

7.   ❑  Note/file __________________

8.   ❑  Please return

9.   ❑  This has my approval

10. ❑  Per your request

NAME
Title
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Facsimile Cover Sheet
To promote consistency and recognition, 
the university created templates for facsimile 
cover sheets. 

Specific guidelines and instructions for how to 
customize the facsimile cover sheet template are 
are embedded in the template. Employees are
encouraged to use the Save As function and rename
their facsimile cover sheet template file with a 
different name so that they may retain the original
master template and instructions on their hard drives
for future use.  

To download the facsimile cover sheet template,  
go to www.sandiego.edu/marketing/stationery.php. 

FACSIMILE COVER SHEET

To: From:

[Click here and type name]
[Click here and type title]

[Click here and type name]
[Click here and type title]

Company: Date:

[Click here and type company name] 3/19/07

Fax number: Total No. of pages, including cover:

[Click here and type fax number] [Click here and type number of pages]

Phone number: Sender’s reference:

[Click here and type phone number] [Click here and type reference number]

Re: CC:

[Click here and type subject of fax] [Click here and type carbon copy]

Urgent For Review Please Comment Please Reply Please Recycle

Notes/Comments:

To save changes to this template for future use, on the File menu, click Save As.

In the Save As Type box, choose Document Template (the filename extensions

should change from .doc to .dot) and save the template. Next time you want to

use the updated template, on the File menu, click New. In the New Document

task pane, under Templates, click On my computer. In the Templates dialog,

your updated template will appear on the General tab.

DEPARTMENT
NAME  

Building Name, Room # 
5998 Alcalá Park, San Diego, 
CA 92110-2492 
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DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.

DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

DEPARTMENT
NAME 

Buiding Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.

DEPARTMENT
NAME 

Buiding Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

Step One: Order stationery 

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.

Step Two: Fill in the memo template Step Three: Final printed memo

Printed Memos
To promote consistency and recognition, the university
created a template to use when writing a memo.
Shown here is the approved template, which must 
be printed on official university letterhead. 

There are three easy steps to printing memos on 
official university letterhead.

• Step One: Employees must order official 
stationery through the University Copy’s website at
www.sandiego.edu/copy. This should be ordered well
in advance. 

• Step Two: Employees must download the memo
template at www.sandiego.edu/marketing/stationery.php
and, using the template, type in the content.
Specific guidelines and instructions for how to 
customize the memo template are are embedded in
the template. Employees are encouraged to use the
Save As function and rename their memo template
file with a different name so that they may retain
the original master template and instructions on
their hard drives for future use.  

• Step Three: Employees must insert the stationery into
their desktop printers and print their newly saved
and updated memo content onto the stationery.
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Electronic Memos
An electronic memo template is also available. 
To download the electronic memo template, 
go to www.sandiego.edu/marketing/stationery.php. 

An electronic memo is to be used in Microsoft Word
and should be used as an attachment to an email.
Electronic memos do not replace memos that are
printed on official stationery. Electronic memos are
meant to be used only electronically. The electronic
memo template contains low-resolution images and
does not reproduce well when printed. Employees

who need or prefer to print the memo, should
instead follow instructions listed in the printed
memo section. 

Specific guidelines and instructions for how to 
customize electronic memos are embedded in the
template. Employees are encouraged to use the 
Save As function and rename their electronic memo
template file with a different name so that they may
retain the original master template and instructions
on their hard drives for future use. 

DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

DEPARTMENT
NAME 

Buiding Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.
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Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File

menu, click New. In the New Document task pane, under Templates, click On my

computer. In the Templates dialog, your updated template will appear on the General

tab.

DEPARTMENT
NAME  
Building Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

MEMORANDUM

To: [Click here and type name]

CC: [Click here and type name]

From: [Click here and type name]

Date: 3/19/07

Re: [Click here and type subject]

How toUseThis MemoTemplate

Select text you would like to replace, and type your memo. To save changes to this 

template for future use, on the File menu, click Save As. In the Save As Type box,

choose Document Template (the filename extensions should change from .doc to .dot)

and save the template. Next time you want to use the updated template, on the File
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computer. In the Templates dialog, your updated template will appear on the General

tab.
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DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

AGENDA

Meeting Title
March 19, 2007
9 a.m. - 5 p.m.

Meeting called by Name

Attendees: Attendee List

Please read: Reading List

Please bring: Supplies List

Additional Instructions:

Use this section for additional instructions, comments, or directions.

9 a.m. – 10 a.m. Introduction
Continental Breakfast
Welcome Kari Hensien

Enter
Speaker

10 a.m. – Noon Demonstrations
New Product Line Jane Clayton
Sales Techniques Jeff D. Henshaw

Enter
Speaker

Noon – 4:00
p.m.

Instructions
To insert or delete rows or columns, use
the Table menu.
To add or remove border lines, use the
Borders and Shading command on the
Format menu.

Enter
Speaker

4 p.m. – 5 p.m. Wrap-up
Questions and Answers All speakers

DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  

DEPARTMENT
NAME 

Buiding Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

AGENDA

Meeting Title
March 19, 2007
9 a.m. - 5 p.m.

Meeting called by Name

Attendees: Attendee List

Please read: Reading List

Please bring: Supplies List

Additional Instructions:

Use this section for additional instructions, comments, or directions.

9 a.m. – 10 a.m. Introduction
Continental Breakfast
Welcome Kari Hensien

Enter Speaker

10 a.m. – Noon Demonstrations
New Product Line Jane Clayton
Sales Techniques Jeff D. Henshaw

Enter Speaker

Noon – 4:00 p.m. Instructions
To insert or delete rows or columns, use the Table
menu.
To add or remove border lines, use the Borders and
Shading command on the Format menu.

Enter Speaker

4 p.m. – 5 p.m. Wrap-up
Questions and Answers All speakers

DEPARTMENT
NAME 

Buiding Name, Room #
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

Step One: Order stationery 

AGENDA

Meeting Title
March 19, 2007
9 a.m. - 5 p.m.

Meeting called by Name

Attendees: Attendee List

Please read: Reading List

Please bring: Supplies List

Additional Instructions:

Use this section for additional instructions, comments, or directions.
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AGENDA

Meeting Title
March 19, 2007
9 a.m. - 5 p.m.

Meeting called by Name

Attendees: Attendee List

Please read: Reading List

Please bring: Supplies List

Additional Instructions:

Use this section for additional instructions, comments, or directions.

9 a.m. – 10 a.m. Introduction
Continental Breakfast
Welcome Kari Hensien

Enter Speaker

10 a.m. – Noon Demonstrations
New Product Line Jane Clayton
Sales Techniques Jeff D. Henshaw

Enter Speaker

Noon – 4:00 p.m. Instructions
To insert or delete rows or columns, use the Table
menu.
To add or remove border lines, use the Borders and
Shading command on the Format menu.

Enter Speaker

4 p.m. – 5 p.m. Wrap-up
Questions and Answers All speakers

Step Two: Fill in the agenda template Step Three: Final printed agenda

Printed Agendas
To promote consistency and recognition, the university
created a template to use when writing an agenda.
Shown here is the approved template, which must 
be printed on official university letterhead. 

There are three easy steps to printing agendas on 
official university letterhead.

• Step One: Employees must order official 
stationery through the University Copy’s website at
www.sandiego.edu/copy. 
This should be ordered well in advance. 

• Step Two: Employees must download the agenda
template at www.sandiego.edu/marketing/stationery.php
and, using the template, type in the content.
Specific guidelines and instructions for how to 
customize the agenda template are are embedded
in the template. Employees are encouraged to use
the save as function and rename their agenda 
template file with a different name so that they
may retain the original master template and
instructions on their hard drives for future use.  

• Step Three: Employees must insert the stationery into
their desktop printers and print their newly saved
and updated agenda content onto the stationery.
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Electronic Agendas
An electronic agenda template is also available. 
To download the electronic agenda template, 
go to www.sandiego.edu/marketing/stationery.php. 

An electronic agenda is to be used in Microsoft 
Word and should be used as an attachment to an 
email. Electronic agendas do not replace agendas
that are printed on official stationery. Electronic
agendas are meant to be used only electronically.
The electronic agenda template contains 
low-resolution images and does not reproduce 

well when printed. Employees who need or 
prefer to print the agenda, should instead follow
instructions listed in the printed agenda section. 

Specific guidelines and instructions for how to 
customize electronic agendas are embedded in the
template. Employees are encouraged to use the 
Save As function and rename their electronic agenda
template file with a different name so that they may
retain the original master template and instructions
on their hard drives for future use. 

DEPARTMENT NAME 
Building Name, Room #  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/department  
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Please bring: Supplies List

Additional Instructions:
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10 a.m. – Noon Demonstrations
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Sales Techniques Jeff D. Henshaw

Enter
Speaker

Noon – 4:00
p.m.
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To insert or delete rows or columns, use
the Table menu.
To add or remove border lines, use the
Borders and Shading command on the
Format menu.

Enter
Speaker

4 p.m. – 5 p.m. Wrap-up
Questions and Answers All speakers
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Athletics Business System
Components that are similar and complementary to
the university’s business system were also designed
for athletics. All components in the athletics business
system are to be used exclusively by collegiate and
club sports programs. If you are unsure if you are
authorized to use the athletics business system, 
contact the Department of Marketing and Strategic
Partnerships. To maintain the integrity of the athletics
business system, these materials must be ordered
only through University Copy’s preferred business
system vendors. 

Athletics Business System Standards
The guidelines, specifications and processes outlined
for the university’s business system also apply to all
components of the athletics business system. 

Shown here are just some of the components 
of the athletics business system:

• Spirit athletics business card option
• Spirit athletics stationery package
• Traditional athletics stationery package

ATHLETICS
Sports Center, Room 111  |  5998 Alcalá Park, San Diego, CA 92110-2492

P: (619) 260-0000  |  F: (619) 260-0000  |  www.sandiego.edu/torero  

ATHLETICS 
Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

ATHLETICS 
Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

ATHLETICS 
Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492

Spirit Athletics Line Traditional Athletics Line (available in two colors or one color)

Spirit Athletics Business Card

ATHLETICS 
Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492

DIEGO THE TORERO
Title
ATHLETICS 

Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492

P: (619) 260-0000, ext. 1111
F: (619) 260-0000

name@sandiego.edu
www.usdtoreros.com

ATHLETICS 
Sports Center, Room 111
5998 Alcalá Park
San Diego, CA 92110-2492
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How to Order Various Components of the
University Business System 
To maintain the visual integrity of all business 
system components, they must only be ordered
through the university’s preferred business system
vendors. Orders may be placed online, through 
the University Copy’s website at
www.sandiego.edu/copy. From there, click on 
the link that says Online Order and follow the
instructions given. 

When placing an order for stationery or business
cards, academic units must include the name of 
the college or school with which they are affiliated,
along with the name of their own center, department,
program or office within that college or school. 

When referring to any program, department or
office, use the official, formal name of a unit, rather
than its more informal name. For example, use the
name Department of Chemistry, rather than the
chemistry department. Or, use the Office of
Assessment rather than the assessment office.

Standards for Filling Out Order Forms
When filling out the order form for business cards 
or stationery, please adhere to these standards: 

• Do not use ampersands. Instead, spell out the
word and.

• Avoid using abbreviations in names.

• While shortening a person’s name is acceptable,
the use of nicknames should be avoided.

• Abbreviations such as Jr. and Sr. should be used
only with full names and should not be preceded
with a comma.

• Avoid using abbreviations in job titles.

• Do not list courtesy titles such as Dr. before a name.
Instead, list degrees after a person’s name. (Right:
Mary E. Lyons, PhD; wrong: Dr. Mary E. Lyons.)

• The business card designs allow employees to list
either the university’s website, www.sandiego.edu, or
other official university websites.  

• Contact numbers — including telephone numbers,
fax numbers and cell phone numbers — should
be formatted using parentheses around the area
code, rather than using hyphens, slashes or periods.
(Right: (619) 260-4600; wrong: 619-260-4600,
619/260-4600 or 619.260.4600.) 

• When listing telephone numbers with extensions,
abbreviate the word extension as ext., preceded
by a comma. (Right: (619) 260-4600, ext. 1111;
wrong: (619) 260-4600 x1111.)

Whom to Contact
It is imperative that all components of the university’s
business system and the athletics business system 
be used correctly. 

• For questions regarding the order or delivery
process of those business system components 
that are handled by University Copy, contact
University Copy directly. 

• For additional assistance on how to use the 
templates or other guidelines outlined in this 
chapter contact the Department of Marketing 
and Strategic Partnerships.




